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Description and Objectives

Course Description

This workbook is for the SMART Competition and contains exercises for crating energy analysis simulations for the sample building project 
and exercises for adjusting the building orientation, investigating solar exposure, investigating daylighting and shading options, trying different 
construction materials and trying different HVAC options for optimum studies of the energy usage of he sample project.

Learning Objectives

Upon successful completion of this course you will be able to:

 Export an analytical space model from AECOsim Building Designer, fixing architectural space errors.

 Run an energy simulation in AECOsim Energy Simulator.

 Investigate solar exposure, roof options and building orientation.

 Run a solar shadows study and add trees and plants.

 Adjust material constructions to optimize the energy efficiency of the building.

 Compare different HVAC systems.

 Run additional energy simulations to compare results.

 Export the design model to LumenRT to generate photo realistic images and fly-through videos.
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Getting Started - The Workspace and WorkSet

Every file created in AECOsim Building Designer should belong to a WorkSet, basically a set of files and folders that all belong to the same 
project. Every WorkSet will belong to a WorkSpace that defines common standards for all the projects in that WorkSpace. In a small 
organization there may be a single WorkSpace for all projects or WorkSets. In larger organizations the WorkSpace may define the standards 
of a particular building type or client.

For the Purpose of the Energy QuickStart Training you will install a WorkSet to the delivered WorkSpace, AECOsimExamples.

1. Unzip the SMART.zip file to:

C:\ProgramData\Bentley\AECOsim CONNECT Edition\Configuration\WorkSpaces\AECOsimExamples\worksets

This should create a sub folder, SMART and two additional files, SMART.cfg and SMART.dgnws under the worksets folder. You now have all 
the files needed to do the exercises outlined in this workbook.

Start AECOsim Building Designer from the Start menu or desktop 
shortcut.

2. Set the Workspace to AECOsim Examples and the WorkSet to 
SMART.

3. Select Browse.

a. Select and Open the file _WorkingModel.dgn.
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Reviewing the Main Application Interface and the Backstage View

Take a few minutes to review the interface, including the ribbon and the various names of the interface components.
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4. From the ribbon interface, click the File tab.

The BackStage view opens.The Backstage view now lists the newly 
opened file and will eventually include more recently opened files. 
The left side of the backstage screen is a File menu including tools 
such as New, Save As, Save Settings, Tools, Utilities, Settings, 
Properties, Print, Export, etc. On the right are buttons for file list 
options: Show Details and Show Thumbnails.

5. Hover the cursor over the file details and right-click.

A pop-menu opens with the options: Open, Open as readonly, Pin to 
list, Remove from list and Open Folder in File Explorer.

6. From the pop-up menu select Open Folder in File Explorer.

An explorer window will open to the folder location of the file.

Hint: This feature allows quick access to the folder location of the 
project.

7. Click back in the AECOsim Building Designer Backstage view and 
press the Escape keyboard key to return to the main application view.
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8. From the Ribbon Interface, open CONNECT Advisor.

CONNECT Advisor is a one stop hub for personalized support and 
training recommendations.  

9. In CONNECT Advisor, set the pull-down to Search and type SMART in the Search field. 

The Connect Advisor will populate with tutorials specific to this SMART tutorial for 
AECOsim Energy Simulator. This includes all the exercises in this workbook.

10. In CONNECT Advisor, set the pull-down to QuickStarts.

The Connect Advisor will populate with additional tutorials for the building tools in 
AECOsim Building Designer. 
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Energy Basics 

Before we start using the software it is important to understand energy basics such as:

 What is energy?

 Forms of energy

 Converting energy

What is Energy?

Energy is a measure of how much work an object or a system can do.

For example, a gallon of gasoline contains enough chemical energy to move an average motor car about 25 miles. The energy in the liquid 
oxygen and liquid hydrogen in the fuel tanks of a Saturn 5 rocket can move the rocket’s payload to the moon. Or, more down to earth, a 
wound-up clock spring contains enough potential energy to make the clock work for perhaps 48 hours before it needs rewinding.

Forms of Energy

There are many different forms of energy, some of which will be very familiar to you but some may be a little less familiar. Some examples of 
commonly encountered forms of energy are solar energy in the form of heat and light energy that we get from the sun, kinetic energy—the 
energy contained in an object by virtue of its motion, potential energy—the energy contained in an object by virtue of its position, and electrical 
energy—the energy resulting from the flow of charged particles; electrons.

Some less familiar forms of energy include chemical potential energy (CPE) – the energy resulting from the position or arrangement of atoms 
that make up a substance. For example the food we eat contains chemical potential energy. When we eat the food the atomic bonds inside 
the food are broken, releasing energy, then the energy is transferred into our bodies. Dynamite contains chemical potential energy! Once 
dynamite is ignited the energy is released extremely quickly, so quickly in fact that an explosion is created. 

Another less familiar form of energy is electromagnetic energy – the energy associated with electric and magnetic fields. It is defined as the 
energy in a magnetic field that is produced by the motion of electric charges such as an electric current. Electromagnetic energy is a very 
fundamental form of energy; light energy is a form of electromagnetic energy.

Energy can neither be created or destroyed, however it can be converted from one form to another. 

In the examples illustrated above we can track how energy is converted from one form into another. The chemical potential energy in the 
gallon of gasoline is converted to kinetic energy when the car starts moving down the road. Likewise in the Saturn 5 rocket, the chemical 
potential energy in the fuel is converted to kinetic energy when the rocket lifts of and starts moving. 
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The wound up clock spring is a little more interesting. The chemical potential energy contained in the muscles of the person who initially 
wound up the clock is converted to potential energy in the spring. The potential energy is slowly converted to both kinetic energy and potential 
energy in the escapement mechanism of the clock.

Energy can be converted from one form into another in many different ways. Naturally occurring energy conversions include photosynthesis, 
where light energy from the sun is converted to chemical potential energy in green plants. Wind is also an example of naturally occurring 
energy conversion. Thermal energy from the sun heats up the ground, the air close to the ground gets warm and rises. As the warm air rises, 
cooler air moves in to take its place. The cool air molecules gain kinetic energy. It is the moving air that makes the “wind” that we feel on our 
faces.

It is not surprising that the examples above both start with solar (light and heat) energy. Our sun is the major source of all energy we use on 
earth today.

All of the machines we use today convert energy from one form into another from which we can obtain some useful work. When energy is 
converted from one form to another less than 100% of the initial energy “makes it”.

One of the fundamental laws of physics, the law of thermodynamics, states that the conversion of energy from one form to another is never 
perfect. Not all the energy will be converted from one form to one other form. In the examples above, in addition to the kinetic energy of the car 
and rocket, the chemical potential energy in the gasoline and rocket fuel is converted into both heat and sound energy. In the example of the 
clock spring, some of the energy in the person’s muscle is converted into heat energy, although not enough to make the person sweat! And 
some of the energy in the clock spring is converted into sound energy, the “tick-tock” we hear from the clock’s works.

Temperature, Thermal Energy, and Heat Transfer

On a microscopic scale, thermal energy is related to the kinetic energy of the atoms and molecules making up an object or system. The 
greater a material's temperature, the greater the thermal agitation and therefore kinetic energy of its constituent molecules.

Temperature is a measurement of the average kinetic energy of the molecules in an object or system and can be measured with a 
thermometer or a calorimeter. It is a means of determining the internal energy contained within the system. 

While temperature represents the amount of thermal energy available in an object or system, heat transfer represents the movement of 
thermal energy from place to place. It is natural for regions containing greater molecular kinetic energy to pass this energy to regions with less 
kinetic energy, i.e., heat transfer is always from a hotter object to a cooler object. Heat transfers to and through some materials better than 
others.

There are three ways in which heat can be transferred from one object or system to another; these are conduction, convection, and radiation.
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Conduction

Conduction is the transfer of heat between substances that are in direct contact with each other. The better the conductor, the more rapidly 
heat will transfer. If one end of a metal rod is at a higher temperature than the other end, then energy will be transferred down the rod toward 
the colder end by the atoms and molecules inside the rod. The higher energy particles will collide with the lower energy particles with a net 
transfer of energy to the lower energy ones

Convection

Convection is the primary method by which heat moves through liquids and gases. It is the up and down movement of liquids and gases 
caused by heat transfer.

As a liquid or a gas is heated, it warms, expands, and rises because it is less dense than the surrounding liquid and gas. When liquid or a gas 
cools, it becomes denser and falls. As the liquid or gas warms and rises, or cools and falls, it creates a convection current. 

Radiation

Electromagnetic radiation in the infra-red frequency range is a form of thermal energy. All sources of heat, the sun, a candle flame, or a camp 
fire for example, all radiate infra-red electromagnetic radiation. When electromagnetic waves come in contact with an object, the waves 
transfer the heat to that object. This is how the “heat” from those sources can be felt by the human body.
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Exercise 01: Exporting the Model to AECOsim Energy Simulation

This exercise will guide the user through the steps needed to create an analytical space model from AECOsim Building Designer. Creating an 
analytical space model (ASM) requires a building location, a building type, and the major components of the building's geometry like walls, 
spaces (areas and volumes), windows and doors (openings). The resulting ASM is a DGN model containing a combination of graphic 
elements and non graphic information that depicts walls, windows and openings as well as the spatial volumes and their physical relationships 
to the building. 

AECOsim Building Designer can create an analytical space model (ASM) DGN that is read and processed directly by AECOsim Energy 
Simulator. See the Help contents for a list of requirements that must be satisfied in the AECOsim building Designer model before it can be 
exported to AECOsim Energy Simulator. 

1. Continue in the file _WorkingModel.dgn.

You will have two views; one an isometric view of the gymnasium building as it sits on the site, and the second a top view of the 
gymnasium building and site. 

2. Use the scroll button on the mouse to zoom in and out to view the entire site. 
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3. If you need to restore the original views select the Apply Saved View tool from the View tab on the ribbon.

a. In the Tool Settings for the Apply Saved View tool, select the desired view, Gym-Iso or Gym-
Top and data point (left-click) in the view window to restore the view.

This working model has been created by referencing other models to this file. You can not actually 
edit any of the geometry of the building in this file. Before creating the analytical space model you will 
want to turn off the site model in order to focus on the gymnasium building.

4. Select the References icon from the Architectural tab on the Ribbon Interface.

a. In the References dialog, select the SMART Site.dgn reference and un-check the display toggle to turn the reference display Off. 

b. Close the References dialog box.
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5. Select the Energy Analysis tool from the Analysis tab on the Ribbon Interface.

6. The Analytical Space Model Explorer will open. 

The dialog shows a list of rooms or spaces, 
organized by floor on the right. It also shows if 
any errors or problem spaces were detected. 
Ideally you should correct any problem spaces 
before exporting the analytical space model.

7. Expand School > Floor 1 

8. Scroll down to see any problem spaces.

In the example there are two problem spaces: 
Plenum - ADMINISTRATION and LOCKER 
ROOM 123. The spaces are missing boundaries. 
The Plenum - ADMINISTRATION space is the 
plenum space above all of the spaces in the 
administration part of the building. To correct both 
of the problem spaces, the wall in LOCKER 
ROOM 123 will be modified, fixing both the 
spaces as the wall is part if the boundary of both 
spaces.
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a. Right-click on LOCKER ROOM 123 and turn on Show missing 
boundaries.

The missing boundary will highlight in the model. 

b. In the Analytical Space Model Explorer, turn on Zoom and Isolate > 
Isolate With Members

This will change the view that is set in the Analytical Space Model Explorer 
(in the example it is set to View 1) so that it is zoomed into the missing 
boundary and only the geometry associated with this space is displayed.

Note that the wall does not go all the way to the ceiling. The red highlight 
shows a missing volume. Next you will modify the wall so that the space is 
enclosed.

9. In the Analytical Space Model Explorer, 
right-click on the space again and turn on 
Activate Model.

The reference model that contains the missing 
boundary will be activated so that it can be 
modified.

10. In the Analytical Space Model Explorer:

a. Turn off the Zoom button.

b. Turn off the Isolate button.

c. Expand the list for the Space: LOCKER 
ROOM 123 space.

d. Select the second Wall: CMU-08 | NR 
wall in the list.

e. Turn on the Select button to select the 
wall.
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11. Select the “Roof” handle at the top of the wall. 

12. Drag it up and move the cursor over the adjacent wall to snap to the top of that wall.

13. Data point (left-click) to accept the modification of the wall.

14. In the Analytical Space Model Explorer, select the Refresh 
button

Note: All errors should now be removed. If you had additional errors 
you would continue to repeat the steps above until all errors were 
removed.

15. In the Analytical Space Model Explorer, select the Export 
button.

Step 11 Step 12 Step 13
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a. Save the file to the /SMART/EnergySim/ folder.

A dialog will indicate “Your file has been successfully exported. Would you like to Open it?”

b. Select Yes.

The analytical space model will open in AECOsim Energy Simulator.

In this process, the architectural spaces are imported into an analytical model for use in AECOsim Energy Analysis energy simulations. An 
analytical space model contains the bound spaces, fenestrations, along with the construction material of the building and are optimized for 
running energy simulations.

For example doors in AECOsim Building Designer are physically represented, the frame, door leaf, view glass, door swing direction, etc.are 
all represented, whereas doors in AECOsim Energy Analysis are represented as openings in the space boundaries. The door openings 
include information about the construction materials of the doors.
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Reviewing the AECOsim Energy Simulator Application Interface 

Take a few minutes to review the interface, including the ribbon and the various names of the interface components
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Exercise 02: Performing an Energy Simulation

This exercise will guide the user through the steps needed to perform a baseline energy simulation. The baseline is intended to provide a 
starting benchmark. Additionally, upon completion of this exercise the user will know how to evaluate the resulting report. 

1. To confirm the settings, open the Analytical Space Model (ASM) Energy Settings & Validation dialog by selecting Validation from the 
Home tab in the ribbon interface.

a. On the 
Energy 
Settings tab 
set the 
Project, 
Regional 
and Building 
information 
as shown in 
the image 
on the right 
and select 
Apply.
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b. On the Room Types tab check that all the rooms have been mapped to a Room Type.

Note: If any rooms are highlighted in red, that indicates that they have not been correctly mapped to a Room Type. You will need to select an 
appropriate Room Type and then select Apply.

c. On the Zones tab, three zones have been defined, AllRooms, Floor 1 and Floor 1 Underfloor. 

d. Select zone Floor 1, 

Note: The Floor 1 zone includes all the rooms in the building except the plenum spaces. Since the plenum spaces are the only areas in the 
building that would not be heated and cooled, you may consider the Floor 1 zone to be all the conditioned spaces in the building. The Add 
icon may be used to create additional zones. For instance, you might create a zone that included all the spaces in the lower portion of the 
building and another zone that included all the spaces in the gymnasium area. 
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e. On the Constructions tab select Use Conceptual Constructions.

These are basic wall, roof, door and window constructions that will be the initial defaults for the building’s materials. The Conceptual 
Constructions could be modified now by selecting the construction and selecting a new construction from the pull-down, however, you will 
modify materials and constructions in a later exercise. 

Note: The default constructions for the project were initially set in the Defaults Manager found on the Data Managers tab.

f. Close the Analytical Space Model (ASM) Energy Settings & Validation dialog.

2. In the Notifications panel there is still one message.

a. Double-click on the message to open the Properties For: Site: Site1 
dialog.
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b. Set the Mains water temp to HVACTemplateSystem‐Always 10 (Value).

The Mains water temp setting is the temperature of the incoming water from the water main supply utility into the building.

c. Set the Terrain information for the site.

d. Scroll down on the list and turn On Use daylight saving, so that the simulation takes into 
account the change in solar location during the months of the year when daylight savings 
time is in effect.

e. Select Apply then OK to close the Properties For: Site: Site1 dialog.

Next you will assign an HVAC system to all the conditioned rooms, all the rooms in the Floor1 
zone.

3. Select the HVAC Systems tool from the Data Managers tab on the Ribbon Interface.
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The HVAC Manager dialog 
and the Designer Toolbox will 
open.

4. In the HVAC Manager, expand 
the HVAC Systems folder and 
select the PTAC Air-Cooled 
DX with Electric Heat.

5. Double-click on the graphic in 
the Designer tab.

The Room Component dialog will 
open.

6. Change the Zone to Floor 1.

7. Move all the available rooms 
in this zone to the Rooms 
using this component list 
using the double arrow.

8. Close the Room Component 
dialog.

9. In the HVAC Manager dialog, 
select Apply then OK to close 
the HVAC Manager dialog.

The set up is complete and you 
are now ready to run the baseline 
simulation.
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10. Select the Simulation tool from the Calculations tab on the Ribbon Interface:

A Simulation dialog 
window will now open. It 
contains the controls 
needed to setup and begin 
a simulation. The 
Calculate tab will allow the 
user to define the 
following: zones of the 
building to be included in 
the simulation, type of 
simulation, the weather 
data to use, and the length 
of the simulation.

11. Click Report Settings 
and a Defaults 
Manager window will 
open.

a. Click in the check 
box for All 
Summary and 
Monthly to select 
all options. 

b. Click Apply and OK 
to save these 
changes and return 
to the Simulation 
window.
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12. Ensure that under 
the Buildings 
heading, School is 
selected.

13. Ensure that under 
Zones heading Floor 
1 is selected.

This will automatically 
highlight all the rooms in 
the Conditioned Rooms 
zone under the Rooms 
heading.

14. A Name is required 
for the simulation, fill 
in the following 
fields: 

a. Name: Baseline 
Simulation ‐ PTAC 
‐ Electric Heat

b. Description: 
Baseline 
Simulation

c. HVAC: PTAC Air‐Cooled DX with Electric Heat

d. Weather data: Raleigh‐Durham Intl. Airp.

Note: This will populate the Heating and Cooling design day dates and temperatures.

15. Select the Full year icon to set the Run period duration to an entire year (Start day: 1/ 1/2018 and End day: 12/31/2018).

a. Select Start and simulation will begin. 
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A Simulation Status message in the Notifications panel indicates the simulation is running. The Simulation window shows the Results tab 
when the simulation is finished and a window named School will open with the detailed results.

16. Select the Save button in the upper right 
corner. 

a. Save this file to an appropriate location.

Note: This is the Baseline Report. The results 
can be accessed at a later time by returning to 
the Simulation window and selecting the 
Results tab near the top of the window. Find the 
simulation title needed and select it. Select the 
Detailed icon in the Show group near the 
bottom right of the window to see the detailed 
results of the simulation.
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Runtime Details

The first tab shows the Runtime Details view, which displays the different calculation design information as an overview.
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Summary Results

This tab contains a comprehensive report on many different aspects of the building design. An Annual Building utility Performance Summary 
is displayed at the top of this tab. the End Uses shows how much energy the various uses, heating, cooling, interior lighting, equipment and 
fans are each consuming.
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Meter

The meter tab displays the simulated power consumption data including minimum and maximum power consumption and corresponding 
dates for different areas of the project building.



Copyright © 2018 Bentley Systems, Incorporated 28DO NOT DISTRIBUTE - Printing for student use is permitted

Room Temperature and Humidity 

The Room Temperature and Humidity tab will show monthly average temperature and humidity results for each room in the building.

Room Daylighting 

The Room Daylighting tab will show the amount of illumination in each room from daylight on a monthly basis. At this point the values are all 
zero because daylighting was not considered in the base simulation. In the next simulation you will turn on the option to turn off interior lights 
when daylight is sufficient in a room, which should reduce the energy consumption from interior lighting.
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Setpoints Not Met 

Scrolling over in the tabs displays the Setpoints Not Met tab, if heating or cooling setpoints are not met in the building these will be displayed 
here.

The results are split into results for the entire building and results for each individual room. For each of the results the table displays the time 
that the heating and cooling setpoint is not met for the month as well as for the occupied period only.
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Economics

Scrolling over in the tabs displays the Economics tab. The economics results display the summary and cost tariff reports for the project 
building economics. The economics result contains a summary report and a tariff report.

The summary report contains a standardized tabular output with two reports that detail the simulated economics, or, calculation of annual 
utility costs for the project building. The economics result summary report displays a summary of multiple cost tariffs defined for the building in 
the properties dialog box. The report gives details on the three different cost types, simulated electricity, gas and other fuels for each cost type 
as well the total of all costs in each row.

Next you will make a global change to all the rooms in the project so that daylighting will be considered when determining the interior lighting 
load, global changes can be made to the surfaces in groups of rooms, zones or the entire building.

17. Select the Changes icon from the Global group on the Home tab as shown below:
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The Global Changes window will appear:

Note: Selecting any of the Zones on the left side of the window 
will automatically highlight the associated rooms located in that 
specific selected zone on the Rooms list (located above the 
Zones list).

18. On the left side of the dialog select the zone Floor 1. 

This will select all the rooms in the zone Floor 1, so that they 
changes made will be made to all the selected rooms.

19. To change the lighting properties, select the arrow to the 
right of Lighting on the right side of the window. 

a. Next, select the box next to Fraction replaceable (a 
check mark will appear). The New data drop down 
menu will become active. Type in 0.9. 

This means that 90% of the interior lighting in any room will be 
replaced with daylighting, when daylight levels are sufficient. In 
other words, the lights can be turned off.

20. Select Apply.

Repeat steps 10 -16 to run a second simulation report, naming 
it Baseline Simulation with Daylight ‐ PTAC ‐ Electric Heat.
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When complete open both reports so that you can compare them side by side. Under the Summary Report compare the End Uses data.

Note: The amount of electricity used for interior lighting has decreased. In addition the cooling load has decreased. Why is that? However the 
Heating load has increased. Why is that?

Base Simulation Base Simulation with Daylight
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Analysis of Simulation Results

Consider the following when evaluating simulation results:

Site energy use: how much energy (kBtu/square foot) will the building use?

Economics: how much will the building owner pay for annual energy bills?

Setpoints met: will building occupants be comfortable?

Simulation Results

As soon as the simulation calculation is complete, the simulation results will be displayed

Runtime Details

The first tab shows the Runtime Details view, which displays the different calculation design information as an overview.

Summary Results

This tab contains a comprehensive report on many different aspects of the building design. Site Energy, Building Area, and Utility Use Per 
Area are displayed near the top of this tab.

Meter

The meter tab displays the simulated power consumption data including minimum and maximum power consumption and corresponding 
dates for different areas of the project building.
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Setpoints Not Met 

Scrolling over in the tabs displays the Setpoints Not Met tab, if heating or cooling setpoints are not met in the building these will be displayed 
here.

The results are split into results for the entire building and results for each individual room. For each of the results the table displays the time 
that the heating and cooling setpoint is not met for the month as well as for the occupied period only.

Room Temperature and Humidity 

Also see the Room Temperature and Humidity tab for monthly average results per room.

Economics

Scrolling over in the tabs displays the Economics tab. The economics results display the summary and cost tariff reports for the project 
building economics. The economics result contains a summary report and a tariff report.

The summary report contains a standardized tabular output with two reports that detail the simulated economics, or, calculation of annual 
utility costs for the project building. The economics result summary report displays a summary of multiple cost tariffs defined for the building in 
the properties dialog box. The report gives details on the three different cost types, simulated electricity, gas and other fuels for each cost type 
as well the total of all costs in each row.
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Exercise 03: Solar Exposure Calculation in AECOsim Building Designer

In this exercise the user will perform a series of solar exposure calculations on the building, using AECOsim Building Designer, to visually see 
how different building orientations change the solar exposure on the various surfaces of the building

1. Start AECOsim Building Designer from the Start menu or desktop shortcut.

2. Set the Workspace to AECOsim Examples and the WorkSet to the workset created earlier.

3. Select Browse.

a. Select and open the _WorkingModel.dgn file.

4. Apply the saved views, Gym-Iso and Gym-Top to View 1and 2 respectively by selecting the Apply Saved View tool from the View tab on 
the ribbon inerface.

a. In the Tool Settings for the Apply Saved View tool, select the desired view, Gym-Iso or Gym-
Top and data point (left-click) in the view window to restore the view.

Before running the solar exposure you will want to turn off the site model to avoid time consuming 
calculations.

5. Select the References icon from the Architectural tab on the Ribbon Interface. 
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a. Select the SMART Site.dgn reference and un-check the display to turn Off the reference display.

6. From the View Control tools, set the View 1 and View 2 Display Styles to Illustration: Shadows.
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The Solar Path

The longitude, latitude and north direction of the site have already been set under the solar properties in the light manager. To better 
understand the current orientation of the building in relation to the sun, use the Edit Solar Path tool to animate the solar path of the sun 
throughout the year. 

7. Set the Workflow to Visualization.

a. Select the Solar Path icon from the Lighting group on the Home tab in the Ribbon Interface.

b. Zoom out a little in each view as needed.

c. Simply drag the sun icon to see its location 
on any given day at any given time. Allow 
the software a couple of seconds to update 
the shadows.

You can visually see how the building casts 
shadows on the local area.

Solar Exposure Calculator

Next you will calculate the solar exposure (hours of 
day exposed to sunlight) of every surface of the 
building using the solar exposure calculator. Ideally 
you will want to calculate solar exposure for each 
season throughout the year, so you will use four 
days throughout the year; the spring equinox (March 
20), the summer solstice (June 20), the fall equinox 
(September 22) and the winter solstice (December 
21). 
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8. Select the Solar Exposure Calculator icon from the Utilities group on the Home tab in the Ribbon Interface.

9. Fill in the Solar Exposure Calculator to indicate the day as shown here:

a. View: 1

b. Increment (minutes): 60 

c. Grid Size (meters): 1.000000

d. Minimum Size (meters): 0.000000

e. Accuracy: Medium

f. Insolation Source: Weather File

Note: Using a weather file will account for the actual number of sunny days based on the 
location specified. Weather files can be found at C:\ProgramData\Bentley\AECOsim 
CONNECT Edition\Configuration\Datasets\EnergyData\Weather Data\Weather Files\.

g. Weather File: USA_NC_Raleigh‐Durham.Intl.AP.723060_TMY3.epw

h. Output: Design File

i. Duration: Day

j. Start Date: 3/20/2018

10. Select OK.

11. Name the new design file _Solar_Baseline‐0320.dgn.

The new design file showing the solar exposure opens. 
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12. Review the results. 

Note: You may wish to save these images as part of a final report.
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Saving Images

13. Select the Save Image icon from the Rendering group on the Home tab. 

a. View: 1

b. Format: Portable Network Graphics

c. Compression: Deflate Compression (Extended)

d. Mode: RGB

e. Shading: From View (Smooth)

f. Light Setup: Active

g. Gamma Correction: 1.70

h. Ignore Lines and Text: Off

i. Antialiasing Quality: High

j. Page Size / DPI: 200

14. Select Save.

By default the image will be saved to the /SMART/Output/ folder, save it here.

15. Go back to the _WorkingModel.dgn and repeat this process for each of the four days listed 
earlier.

Note: Name each solar exposure file as a series that indicates the settings, such as:

_Solar_Baseline‐0620.dgn

_Solar_Baseline‐0922.dgn

_Solar_Baseline‐1221.dgn
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Exercise 04: Changing the Building Orientation

Changing the building’s orientation will also affect which surfaces receive the greatest exposure to the sun. Since the building model, 
Gym.dgn is referenced to the _WorkingModel.dgn, you can easily change its orientation on the site. The site is situated so that North is 
directly up along the Y-axis.

1. Return to the _WorkingModel.dgn file.

2. Open the ReferenceS dialog from the Home tab on the Visualization workflow in the Ribbon Interface..

a. Select the Gym.dgn reference file and type in various angles in the Rotation field; this will rotate the building on the site. .

3. Rerun solar exposure calculations for as many rotations as you choose to study until you feel you have found the optimal orientation for 
the building.

4. Back in the _WorkingModel.dgn file, use the keyboard shortcut, Ctrl‐F, to apply a Save Settings to save the current settings.



Copyright © 2018 Bentley Systems, Incorporated 42DO NOT DISTRIBUTE - Printing for student use is permitted

Exercise 05: Roof Options

There are various ways to reduce the amount of solar exposure on a building. Different roof configurations might increase the amount of 
surface area exposed to the sun, or they might shade other surfaces of the building. 

1. Continue in the _WorkingModel.dgn file.

2. Open the References dialog.

3. Select the Show Hierarchy button and expand the tree in the left-hand field so that you can see all the reference files attached to this 
model.

a. Select the file PMM, Gym.dgn, _PMM. 

In the right field you will see all the reference files that are attached to Gym.dgn. These are known as nested references. You will note that 
along with the Civil Site, the Building and the FFE (furniture, fixtures and equipment) model there are four Roof Options and two Window 
Shade options.

b. Turn the display Off for Gym Roof Option 1 and the display On for Gym Roof Option 2.
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Note: The the roof of the gymnasium changes showing the different option, like steeper slope, sloped on one direction, etc.

4. Rerun the solar exposure calculations to see if it improves the solar exposure. 

5. Do the same for the other roof options. Determine your preferred option.

As a bonus, you might want to create your own options for a roof. Open the file Gym.dgn and create new models within the file by copying one 
of the delivered options and then modifying the geometry. See the Help files for more information on creating models. For creating 3D objects 
investigate the tools in the Modeling Workflow, Forms and Solids tabs. 

In addition, the Roof tool in the AECOsim Workflow, Architectural tab is a useful tool for creating sloped roofs.

Now that you have selected the building orientation and roof preference you will export the revised model to AECOsim Energy Simulator for 
energy analysis.
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Exercise 06: Exporting the Updated Model to AECOsim Energy Simulator

As shown in Exercise 1, this exercise goes through exporting the adjusted model from AECOsim Building Designer to AECOsim Energy 
Simulator.

1. Return to the _WorkingModel.dgn file.

2. From the Reference dialog ensure that the SMART Site.dgn is displayed Off and that the selected roof option is displayed On.

3. Select the Energy Analysis tool from the AECOsim workflow, Analysis tab on the Ribbon Interface. 

4. The Analytical Space Model Explorer will open. 

a. Correct any problem spaces before exporting the analytical space model.

5. Select Export...

a. Save the file to the /SMART/EnergySim/ folder, naming it in a descriptive way that includes the building rotation and roof option, such 
as 045-Roof2 ASM.dgn.

The export process will process the model from AECOsim Building Designer.

A dialog will indicate “Your file has been successfully exported. Would you like to Open it?”

b. Select Yes.

6. Review Exercise 02: Performing A Simulation to set up the file and run a new simulation.
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Exercise 07: Solar Shadows Study

As we move outside the building and into the campus we will look at solar study considerations for placement of vegetation, green building 
campus considerations and elements that represent power generation for the campus.

1. Start AECOsim Building Designer from the Start menu or desktop shortcut and open the file _WorkingModel.dgn.

Solar Shadow Study

Next you will do a solar shadow study using the Solar Study tool. Again, you will use four days throughout the year; the Spring Equinox, the 
Summer Solstice, the Fall Equinox, and the Winter Solstice. 

Before running the solar shadow study you will want to turn the site reference model back on.

2. Select the Reference icon from the Architectural tab on the Ribbon Interface. 

a. Select the  Site.dgn reference and check on the display toggle to turn On the reference display.
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3. Set the Workflow to Visualization.

4. Select the Solar Lighting icon from the Utilities group on the Home tab in the Ribbon Interface.

5. Fill in the Solar Study parameters:

a. View: Select a view that you would like to use, this could be a top view or even a front or side 
view. To start, use a top view. 

b. No. of Frames: The study can be saved as either images or an animation. This number 
should coordinate with the Duration, so if the Duration is 9 hours, make the number of images 
10, so that there is an image for each hour.

c. Speed: This setting affects animations, the higher the number the slower the speed.

d. Render Setup: Untitled

e. Render Mode: From View. The view should have a display style set to Monochrome: 
Shadows.

f. Antialias: None

g. Start Time: Set the Time and Date for a start of the solar study.

Note: Dates for the equinoxes and solstices (2018): March 20, June 21, September 22, 
December 21

h. Duration: Set the Total Time in hours for the solar study.

6. Select Save.

The solar study can be saved as a series of images in a number of different formats or as an animation, such as an FLI file that will run in 
QuickTime.

By default it will be saved in the output folder within the support folder of the workset project folder.
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7. In the Record Sequence dialog rename the file to indicate the date used for the solar study, e.g., 2018-03-20_WorkingModel.

8. Clik the OK button.

9. Once finished, open the solar study and review where the shadows are generated from the building.

Note: A quick way to access the workset folder is to go select the File tab (this opens the backstage page), right-click on file name and 
select Open Folder in File Explorer.

Which parts of the building shade other parts of the building? Does the roof provide shade to the building? Do the solar shading devices 
provide shade to the building? Repeat this process for the four times of year. Again review the different solar studies. Does the building 
receive more shading at certain times of the year?

Next you will locate trees on the site to help shade the building.

Adding Trees

Based on the solar study and the solar exposure calculations done earlier, determine where you would like to provide more shade to the 
building. Think about the size and type of trees and the location that would best provide that shade.

10. Set the Workflow to Visualization.

11. Select the Populate icon from the Utilities group on the Home tab in the Ribbon Interface.

12. In the Tool Settings for the Populate tool dialog set:

a. Content: LumenRT Plants

b. Item: Select the tree type you wish to place
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Note: Use the browse icon (the ... icon) to open the Populate Contents 
– Trees dialog. Here you can see a list of all the tree types available to 
you and the tree height. There are additional plants in the XFrog Plants 
content option.

c. Alignment: Vertical

13. Using the Place Single icon place a tree with a datapoint (left-click) in the 
model. It will be placed on the ground surface. 

Place as many trees as you like based on both the need for shade on the 
building and daylight within the building at various times of the year. Pay 
attention to whether the tree type is an evergreen or deciduous tree, because 
although the tree cells all have leaves and provide shade in the solar study, 
they do not all have leaves throughout the year.

14. Rerun the solar studies with the trees in place and compare to the solar 
studies run earlier.

To further understand the effect of the trees on the building run a new solar 
exposure calculation (done in exercise 3) and compare to the one run without 
trees.
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Exercise 08: Daylighting and Shading Devices

In this exercise you will add external shading devices, or fins, to the building and run a fourth simulation.

1. Continue working in the same ASM file.

In order to further reduce the solar gain you may have added window shading devices and roof overhangs to the building model. While 
external shading devices can reduce the solar gain in the summer months they may also reduce the passive solar heat gain in the winter 
months increasing the heating required. They might also reduce the natural daylight, increasing the interior lighting required. By adding this 
data to the Analytical Space model, you can determine if these devices are increasing or decreasing the energy consumption.

On the Home tab select the Add Fin icon from the Embedded Surfaces group.

2. In the Tool Settings dialog for the Add fin tool set the following:

a. FinType: SMART Shade Option 1 [2] projecting form window head

b. Leave all values to the defaults.

3. Select one of the windows on the Gym building, this will actually select the entire wall 
that the window is set in.

a. Right-click to un-select the wall and select just the window.

b. Start drawing the fin by selecting a datapoint (left-click) at one end of the run of 
windows and selecting a second datapoint (left-click) at the other end of the run of 
windows. The fin is created and highlighted in the model. 

Note: If the fin as been created in the wrong direction, right-click on it in the Project Tree 
and select Properties. Modify the Length property to a negative number.

4. Repeat for the other two sides of the Gym building.

You can also use a solid fin to create the roof overhang.



Copyright © 2018 Bentley Systems, Incorporated 50DO NOT DISTRIBUTE - Printing for student use is permitted

5. On the Home tab select the Add Fin icon from the Embedded Surfaces group.

6. In the Tool Settings dialog for the Add fin tool set the following:

a. FinType: SMART Shade Option 1 [2] projecting form window head

b. Leave all values to the defaults.

7. Select one of the walls on the Gym building. 

a. Start drawing the fin by selecting a data-point at one end of the wall and selecting a 
second data point at the other end of the wall. The fin is created and highlighted in 
the model. 

Note: If the fin as been created in the wrong direction, right-click on it in the Project Tree 
and select Properties. Modify the Length property to a negative number.

8. Repeat for the other sides of the Gym building that have a roof overhang.

9. Run a new simulation, naming the simulation report in a descriptive way that indicates 
this simulation includes shading devices. 

a. Name: Simulation with Shading Devices ‐ PTAC ‐ Electric Heat

b. Description: Simulation with Shading Devices and PTAC Electric Heat

Compare this report with the previous report. Was the cooling load reduced? Was the entire 
electrical load increased or decreased?
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Exercise 09: Changing Material Constructions

This part of the tutorial will guide the user through making various updates that will impact energy usage, by changing the building’s material 
and glazing options.

1. Continue working in the same ASM file.

Materials and construction were originally assigned to all the surfaces of the ASM when 
the model was originally brought into AECOsim Energy Simulator (see Exercise 01 in the 
ES101 cousrse). 

The AECOsim Energy Simulator Project Tree window allows the user to select specific 
rooms and view the material types (along with associated properties). The default 
construction for all the exposed floors in the SMART project was set as a carpet on a 
concrete slab. However the gym floor should be changed to a wood floor. You will make 
this change from the Project Tree. 

2. First, select the room in the Project Tree, Room: GYM 134 as shown here.

Note: The room is highlighted in the geometry model views; this highlighting feature 
continues as other building elements are selected in the Project Tree.

3. Next select the arrow to the left of the room to expand the list. Within this list select 
the arrow next to Surfaces.

This will display items such as Exposed Roof, Exposed Wall, Ground Floor and Partition. 

4. In the Surfaces list, right-click on Ground Floor and select Properties to see the 
material type (and associated properties). 
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a. Change the Construction to SMART Wood on Slab Floor.

b. Select Apply and OK.

In addition to individually changing materials on surfaces from the project tree, global changes can be made to the surfaces in groups of 
rooms, zones or the entire building.

5. Select the Changes icon from the Global group on the Home tab as shown below:
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The Global 
Changes window 
will appear:

Let’s assume we 
want to change all 
the windows in the 
building to have a 
different glazing 
type. 

Note: Selecting any 
of the Zones on the 
left side of the 
window will 
automatically 
highlight the 
associated rooms 
located in that 
specific selected 
zone on the Rooms 
list (located above 
the Zones list).

6. On the left side 
of the dialog 
select the zone 
AllRooms. 

7. To change the 
window type, select the arrow to the right of Windows on the right side of the window. 

a. Next, select the box next to Window type (a check mark will appear). The New data drop down menu will become active. Select the 
arrow to see and scroll through options. 

b. Select a the window type, SMART Glazing Double Pane.

8. Select Apply.

9. Before running a simulation, click Save at the top of the AECOsim program window to save any changes made since the last simulation.
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10. Run a new simulation, naming the simulation report in a descriptive way that indicates this simulation includes double pane window 
glazing. 

a. Name: Simulation with Double Pane Windows ‐ PTAC ‐ Electric Heat

b. Description: Simulation with Double Pane Windows and PTAC Electric Heat

Compare this report with the previous reports. Next, you will change the construction of the walls and roof of the gym building.

11. In the Rooms list, select Floor 1 Ceiling: Plenum ‐ GYM.

12. To change the roof type for the sloped roof over the gym, select the arrow to the right of Roof on the right side of the window. 

a. Next, select the box next to Roof type (a check mark will appear). The New data drop down menu will become active. Select the arrow 
to see and scroll through options. 

b. Select the roof type, SMART Standing Seam Metal Roof.
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c. Select Apply.

In addition to changing the roof over the gymnasium, you may wish to change the wall construction around the gymnasium.

13. Select the Changes icon from the Global group on the Home tab.

14. In the Rooms list, select Floor 1: GYM 134.

15. To change the wall construction for the gym, select the arrow to the right of Wall on the right side of the window. 

a. Next, select the box next to Wall type (a check mark will appear). The New data drop down menu will become active. Select the arrow 
to see and scroll through options. 

b. Select the wall type, SMART Steel Framed Wall.

c. Select Apply.

16. Close the Global Changes dialog.
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17. Before running a simulation, click Save at the top of the AECOsim program window to save any changes made since the last simulation.

18. Run a new simulation, naming the simulation report in a descriptive way that indicates this Simulation includes new constructions. 

a. Name: Simulation with Metal Roof Steel Framed Walls on Gym ‐ PTAC ‐ Electric Heat

b. Description: Simulation with Metal Roof Steel Framed Walls on Gym and PTAC Electric Heat

Compare this report with the previous reports. 
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Exercise 10: Managing Materials

The materials manager allows the modification of material constructions so that you can create and test constructions that might improve the 
energy performance of the building

1. Select the Materials icon form the Data Managers tab in the Ribbon Interface. .

The Materials Manager dialog will open. The Application tab will show a library of 
constructions that can be copied to the Project tab for use in the project. A small 
library of constructions has already been copied to the SMART project. Once in the 
project they can be modified.

2. Expand the Roof group and select the SMART Metal Deck + Built Up Roof. This is 
the roof construction that is applied to the lower, administrative portion of the building.
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On the right of the dialog each layer of the roof construction is defined along with a graphic preview. 

3. Select layer 2. ASHRAE ‐ Insulation board and expand it to see the properties.

a. Change the thickness from 2 in, to 4.00 in.

b. Select Apply.

4. Repeat for the SMART Standing Seam Metal Roof material.

You could make similar changes to the wall constructions.

5. Select the Materials icon form the Data Managers tab in the Ribbon Interface. 

6. Expand the Wall group and select the SMART Steel Framed Wall. This is the wall construction that is applied to the Gym.

On the right of the dialog each layer of the wall construction is defined along with a graphic preview. 
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7. Select layer 4.ASHRAE - Stucco and Delete.

8. Select Add to add a new layer. 

a. From the pull-down for the new layer select Insulation > ASHRAE ‐ EIFS finish.

EIFS is an exterior insulated finishing system. It has an appearance similar to stucco, with increased insulation properties.

b. Change the Thickness to 1.50 in.

c. Check Continuous Insulation.

9. Select Apply and then OK to close the Materials Manager. 

Next, a simulation will be performed to determine how the changes made to the model have impacted different results parameters. 

10. Before running a simulation, click Save at the top of the AECOsim program window to save any changes made since the last simulation.

11. Run a new simulation, naming the simulation report in a descriptive way that indicates this Simulation includes new constructions. 

a. Name: Simulation with Wall and Roof Insulation‐ PTAC ‐ Electric Heat

b. Description: Simulation with Wall and Roof Insulation and PTAC Electric Heat

Compare this report with the previous reports. 

Experiment with other materials and constructions to create an energy efficient envelope for the building.
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Exercise 11: Updating the Building Materials

In this exercise you will make changes to the wall constructions in the building model to match the materials and constructions that were 
chosen in the previous simulations in AECOsim Energy Simulator.

1. In AECOsim Building Designer, continue in the _WorkingModel.dgn file.

Note: If you are starting a new session of AECOsim Building Designer remember to start with these steps:

a. Start AECOsim Building Designer from the Start menu or desktop shortcut.

b. Set the Workspace to AECOsim Examples and the WorkSet to SMART.

c. Select the _WorkingModel.dgn file (it will be in the list of files from being opened in a previous session).

In order to change the materials on the school model you will open the Schedules dialog and modify the part assigned to the building 
elements.

2. Select the Schedules tool from the Data group on the Data/Reporting tab.
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3. Expand the Catalog Types 
on the left side of the dialog 
to show Architectural > Roof 
> SMART Layout.

a. From the right side of the 
dialog select the roof over 
the gymnasium building. 
(The roof will highlight in 
the model as it is 
selected.)

b. Double-click on the Part 
Definition field.

4. Select a different Part 
Definition, such as 
Panel_Standing_Seam_Met
al

Next, you will change the construction of the walls around the gymnasium by modifying the parts assigned to the various walls.

5. Expand the Catalog Types 
on the left side of the dialog 
to show Architectural > Walls 
> Wall > SMART Layout.

a. From the right side of the 
dialog select all the walls 
with a ID | Type ID of G1. 
(The data can be sorted 
by clicking on each 
column header.)

6. Right-click on the data in the 
Part Definition field and 
select Edit Values
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b. Select a different Part 
Definition, such as 
WallComponents > Brick.

The Brick part will be assigned to 
all the walls around the 
gymnasium.

Select all the A1 walls in order to 
change the wall material on the 
administration part of the school.

7. Close the Schedules dialog.

8. Set the Display Style on the 
model to Illustration:Ignore 
Lighting to see the changes 
you have made.
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Exercise 12: HVAC Modifications

This part of the tutorial will guide the user through making various updates that will impact energy usage by modifying the heating, ventilation 
and air conditioning (HVAC) system.

Making changes to the efficiency and performance ratings of the HVAC system

Each HVAC system has different key variables that can be adjusted to alter the system’s energy usage. Examples include coefficient of 
performance (COP), supply-air fan efficiency, motor efficiency, etc. In order to better understand the impact of changing such variables, 
simulations will be run before and after the variables are changed. The steps below outline where to find the variables in the HVAC manager.

Different HVAC systems have different key components that can be changed. Therefore, four different HVAC systems will be assigned to the 
building to generate four separate hypothetical building set-ups. Simulations will be performed before and after for each of the four set-ups.

This will require selecting and assigning a new HVAC system to the building then removing the assignment. These steps will be performed in 
the HVAC manager as detailed below.

1. Select the HVAC Systems tool from the Data Managers tab in the Ribbon Interface.

The HVAC Manager and the Designer Toolbox dialog boxes open. The Designer Toolbox can be used by mechanical engineers to design 
HVAC systems from scratch. For the purposes of this course the Designer Toolbox is not used, we will use four predefined systems defined 
for this project.

2. Select the Project button.

3. In the HVAC Systems list expand HVAC Systems

4. Select the PTAC Air‐Cooled DX with Electric Heat system.

5. Click on the Data tab.
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The HVAC Manager dialog box is 
used to manipulate HVAC systems, 
sub-systems, and component data. 
Controls and settings are provided for 
adding and modifying new 
components and sub-systems. 
Virtually all EnergyPlus HVAC objects 
and properties are available to 
accurately create any HVAC system 
desired.

The following four HVAC systems 
have been added to this project for 
use in this exercise:

 PTAC Air-Cooled DX with 
Electric Heat (baseline 
system)

 PTAC Air-Cooled DX with 
Hot Water Heat

 PTHP Air-to-Air DX with 
Electric Supplemental Heat 
and Central Ducted DX-
based DOAS

 Water-Source Heat Pump

There are two methodologies available for adding or modifying HVAC data in the HVAC Manager: the Designer mode and the Data mode. 
Both are contained within the HVAC Manager dialog box and will be displayed whenever a HVAC system, sub-system, or component is 
selected. Systems can be modified on the Data tab in numerical form or in a graphical form through the Designer tab.

In this exercise, all edits will be made using the Data tab.

Note: To see a more detailed view of each system, right click on any component under the main system title in the Project Tree and select Edit 
Component (if available). 



Copyright © 2018 Bentley Systems, Incorporated 65DO NOT DISTRIBUTE - Printing for student use is permitted

HVAC Component properties

When a component is selected and added to the active HVAC system or subsystem, its data is enabled and available for modification in a 
dedicated properties panel.

The objects selected from the component drop list vary greatly in their properties. EnergyPlus, where the components originate, provides a 
comprehensive listing of all HVAC objects and their properties. For more information on EnergyPlus visit https://energyplus.net/

Required properties

A subset of component properties is required for the HVAC system to simulate successfully. That is, they must be defined if they are set to 
undefined. These properties are denoted by a red asterisk character, as seen in the screen shot below.

Required properties vary for different types of HVAC systems. This section will review how to edit selected properties using the baseline 
system as an example; follow these steps to edit properties in whichever HVAC system is selected for the final model. Additional notes on 
each of the four HVAC systems are included at the end of this section.
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The screen shot below shows the Data tab variables for the baseline HVAC system. To edit any of these variables, simply click in the field and 
replace the existing value with a new value. Refer to the end of this section for guidance on which values may be edited for each of the four 
suggested HVAC systems.

After values have been edited as desired, click Apply to save any changes made to the settings for the four systems. 
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Applying HVAC system changes to the building zones

After changes are made to different parts of the HVAC system, the rooms that will utilize the system need to be assigned properly to ensure 
the changes are applied. 

6. In the HVAC Manager window, switch to the Designer tab.

7. Right-click on the Room Component – PTAC with Air-Cooled DX Cooling and Electric Heat image and select Properties.

The Room Component window opens.
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8. Use the arrows to move all the rooms under the Rooms using this component list. :

9. Ensure that Default is highlighted in the Rooms using this component list and in the HVAC Manager window click Apply.

10. Click OK to save the changes and exit the HVAC Manager.

After all desired edits have been made and applied to the HVAC system, refer back to Exercise 02 of this tutorial for guidance on how to run 
a simulation and save the results to a PDF. 
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Guidance on Property Values To Be Edited In Each HVAC System

PTAC Air-Cooled DX with Cooling with Electric Heat

The packaged terminal air conditioner (PTAC) is a compound object made up of other components. Each PTAC consists of an outdoor air 
mixer, direct expansion (DX) cooling coil, heating coil (gas, electric, hot water, or steam) and a supply air fan. The packaged terminal air 
conditioner coordinates the operation of these components and is modeled as a type of zone equipment.

PTAC units are often used in schools, hotel rooms, hospitals, etc.

Below is a list of variables that may be edited within this system, with a recommended range of values for each.

PTAC with Air-Cooled DX Cooling with Electric Heat  

Room Component

Property Values

Supply Air Fan Efficiency Default 0.50, Range 0‐1

Supply Air Fan Pressure Rise Default 0.40, Range 0‐1

Supply Air Fan Motor Efficiency Default 0.60, Range 0‐1

Supply Air Fan Motor In Airstream Fraction Default 1.00, Range 0‐1

Rated Cooling COP (Gross) Default 3.00, Range 2.5 to 5
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PTAC Air-Cooled DX with Hot Water Heat :

Variable Speed Hot Water Pump

Property Values

Motor Efficiency 0.77, Range 0‐1

Hot Water Boiler with Generic Performance Curve

Property Values

Boiler Nominal Thermal Efficiency 0.80, Range 0‐1

Room Component

Property Values

Supply Air Fan Efficiency Default 0.50, Range 0‐1

Supply Air Fan Pressure Rise Default 0.52, Range 0‐1

Supply Air Fan Motor Efficiency Default 0.60, Range 0‐1

Supply Air Fan Motor in Airstream Fraction Default 1.00, Range 0‐1

Rated Cooling COP (Gross) Default 3.00, Range 2.5 to 5
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PTHP Air-to-Air DX with Electric Supplemental Heat

The packaged terminal heat pump (PTHP) is a compound object made up of other components. Each PTHP consists of an outdoor air mixer, 
direct expansion (DX) cooling coil, DX heating coil, supply air fan, and a supplemental heating coil as shown in the figure below. The 
packaged terminal heat pump coordinates the operation of these components and is modeled as a type of zone equipment.

Below is a list of variables that may be edited within this system, with a recommended range of values for each.

PTHP Air-to-Air DX with Electric Supplement Heat and Central Ducted DX-based DOAS

Room Component

Property Values

Supply Air Fan Efficiency Default 0.50, Range 0‐1

Supply Air Fan Pressure Rise Default 0.40, Range 0‐1

Supply Air Fan Motor Efficiency Default 0.60, Range 0‐1

Supply Air Fan Motor in Airstream Fraction Default 1.00, Range 0‐1

Rated Cooling COP (Gross) Default 3.00, Range 2.5 to 5

Rated Heating COP (Gross) Default 2.75, Range 1.75‐4
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Water-Source Heat Pump

The water-source heat pump is composed of several major components.The water-source heat pump is not a geothermal heat pump. A 
geothermal heat pump is connected to a loop that circulates water to a loop in the ground. Water-source heat pumps are connected to a 
common water loop controlled to maintain temperatures between 60°F and 90°F. Each heat pump unit contains a fan, heating and cooling 
coils, and outside air intake. Heat pump units are located in each room or zone. The heat pump water loop also includes a boiler (to add heat 
to the loop), a cooling tower (to remove excess heat), and a pump to circulate the water. 

Below is a list of variables that may be edited within this system, with a recommended range of values for each.

Water Source Heat Pump

Hot Water Boiler with Generic Performance Curve

Property Values

Boiler Fuel Type Default: Natural Gas

Options: Electric, Natural Gas, Propane 
Gas, Fuel Oil #1, Fuel Oil #2, Coal, Diesel, 
Gasoline

Boiler Nominal Thermal Efficiency Default 0.8

Room Component

Property Values

Supply Air Fan Efficiency Default 0.52, Range 0‐1

Supply Air Fan Pressure Rise Default 1.32, Range 0‐1

Supply Air Fan Motor Efficiency Default 0.80, Range 0‐1

Supply Air Fan Motor in Airstream Fraction Default 1.00, Range 0‐1

Rated Cooling COP (Gross) Default 5.12, Range 2.5 to 5

Rated Heating COP (Gross) Default 4.75, Range 1.75‐4
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Exercise 13: Updating the HVAC System in AECOsim Building Designer

Examples of the four different HVAC systems you can analyze in AECOsim Energy Simulator have been modeled in AECOsim Building 
Designer, including the different roof arrangements of the gymnasium. The options are included as reference attachments to the _Working 
Model.dgn file. In this exercise the Reference dialog box is used to turn off and on the various HVAC configurations.

1. In AECOsim Building Designer, continue in the _WorkingModel.dgn file.

Note: If you are starting a new session of AECOsim Building Designer remember to start with these steps:

a. Start AECOsim Building Designer from the Start menu or desktop shortcut.

b. Set the Workspace to AECOsim Examples and the WorkSet to SMART.

c. Select the _WorkingModel.dgn file (it will be in the list of files from being opened in a previous session).

2. Select the References dialog from the Ribbon Interface, Common Tools group.

3. Select the Show Hierarchy button and expand the tree in the left-hand field and select the PMM, Gym.dgn reference.

4. Turn on the display for the Gym‐HVAC.dgn reference.

5. Select the file HVAC Master, Gym‐HVAC.dgn reference.
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6. In the hierarchy list. expand the tree for the PMM, Gym.dgn reference and select the Gym‐HVAC.dgn reference.

The list of references show the nested attachments for the Gym‐HVAC.dgn reference.

7. Use the Display column to toggle off and on the different HVAC models representing the different options.

Note: The the reference descriptions reflect the name of the HVAC systems utilized in AECOsim Energy Simulator analysis done in the 
previous exercise. Also, there are different models for the roof options of the gymnasium PTHP Air-to-Air with Electric Supplemental Heat and 
Central Ducted DX-based DOAS system. This is the only system that has equipment on the rooftop of the gymnasium, so utilize these in 
conjunction with the architectural reference roof options.

The PTAC Air-Cooled DX with Hot Water Heat system includes a boiler room (separate from the school building and the Water-Source Heat 
Pump system adds a chilled water unit as well.
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Use these options in the subsequent solar study and visualization exercises to reflect the system your project is using.
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Exercise 14: Energy Simulator Tutorial: Final analysis

General Procedure for developing a final model:

Perform a simulation.

Review the results.

Modify model variables and perform simulation.

Compare results to your previous models as described below:

Site energy use: how much energy (kBtu/square foot) will the building use?

Economics: how much will the building owner pay for annual energy bills?

Setpoints met: will building occupants be comfortable?

After all the desired edits have been made and applied to the building, refer back to Exercise 01 of this workbook for guidance on how to run 
a simulation and save the results to PDF for analysis.

Your final solution recommendations should also include how the site affects the surrounding community including power generation, power 
distribution and power storage. Refer to section three—six of the lesson narrative documentation.
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Exercise 15: AECOsim Building Designer and LumenRT: Visualization

In preparation for your final deliverables this tutorial will walk you through options to create visualization 
and videos of your design with LumenRT, an AECOsim Building Designer companion software for real-
time visualization.

AECOsim Building Designer can export the model to LumenRT, which creates a “Live Cube”, where 
visualization, video and animation can be quickly generated. In this exercise the model is exported to 
LumernRT. In LumenRT renderings and videos are generated to be included in your project.

To prepare the model for export to Lumen RT first you will turn some levels off.

1. Set the Workflow to AECOsim and select the Level Display tool.

2. In the Level Display dialog set:

a. Highlight the reference PMM,Gym.dgn

b. Click the Used column header twice to sort the levels by usage.

c. In the list of levels click the levels as shown in the image to the right.

Levels with a blue background are on, levels with a white background are off.

d. Click the Apply to Open Views tool to apply the settings to all the open views.

3. Select the Save Settings tool in the Quick Access tool bar.
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4. Set the Workflow to Visualization.

5. Select the LumenRT icon from the Utilities group on the Home tab in the Ribbon Interface.

6. An Alert dialog box opens, click the Proceed button.

The LumenRT application will process the model from AECOsim Building Designer and open.

7. In the LumenRT toolbar, select the Sun & Atmosphere Settings tool.

8. Right-click the World Map tool to access the Location dialog.
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9. In the Location dialog select Raleigh (United States, N.C.) from the pick list.

10. Turn on the Daylight saving time toggle.

11. Click OK in the Location dialog.

12. In the Sun & Atmosphere Settings expand the SUN POSITION settings and click the Time toggle to switch day/night to day.

13. On the lower right of the interface set the Display Setting to three stars.
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14. Review the LumenRT interface:

1. Main Side‐Bar Menu: accessed by pressing the tab key and contains all of the top level LumenRT tools.

2. Side‐Bar Sub Menu: displays the sub menu options for the main Side-Bar tools.

3. Navigation Compass: displays the camera direction with a red true north indicator.

4. Basic Navigation Control Help Menu: an optional help screen showing the high level mouse and key navigation commands.

5. Scene Display: the main window for displaying scene objects and content.

6. Atmosphere: the dynamic sky, clouds, haze, and sun display.

7. Display Quality: clicking the stars sets the display quality from 1 star (low) to 5 stars (high)
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15. Right-click on the Photo tool to access the photo options and set:

a. RESOLUTION:

 Aspect Ratio: Standard PC (4:3), 1024 x 768

b. WHEN I CLICK THE PHOTO ICON

 Save photo to disk: On

 Add to photo strip: On

 QUALITY: Standard

c. DESTINATION:

 Other: Set this to a location on you computer. e.g., 
C:\ProgramData\Bentley\AECOsim CONNECT 
Edition\Configuration\WorkSpaces\AECOsimExamples\worksets\SMA
RT\Output\

 Save as: Give the file a name, e.g., My SMART Building 01

d. FORMAT:

 Standard

16. Click OK.

17. Click the Photo tool to save the photo.

18. Click OK in the alert dialog box.



Copyright © 2018 Bentley Systems, Incorporated 82DO NOT DISTRIBUTE - Printing for student use is permitted

19. In Windows Explorer browse to the location the file was saved to review the photo.

20. Rotate the live cube to another orientation.

21. Click on the Photo tool to take another photo.
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LumenRT will save the images with a sequential numbering, e.g., My SMART Building 01_001.jpg, My SMART Building 01_002.jpg

22. Take a few photos. These will be added to the photo strip in the Movie tool.

23. Click on the Movie tool.

24. In the Movie interface select Movie Editor tab.

25. Preview the movie by selecting the Play tool.

The movie tool will “stitch together” the saved photos and move the camera accordingly to create a movie.

26. Select the Export Movie tool.

27. In the Movie Options set:

a. RESOLUTION: 720p HD (1280 x 720)

b. DESTINATION:

 Other: Set this to a location on you computer. e.g., 
C:\ProgramData\Bentley\AECOsim CONNECT 
Edition\Configuration\WorkSpaces\AECOsimExamples\worksets\S
MART\Output\

 Save as: Give the file a name, e.g., My SMART Building Movie 01

c. QUALITY: Standard

d. VIDEO ENCODER: MPEG‐4 part 2

 Frame Rate: 30 fps

e. FORMAT: Standard

28. Click OK.

An MPEG-4 movie is generated, this will take several minutes depending on the computer you are using.

29. From the Main Side-bar menu select the File tool.

 Right-click on the Save tool and save the LumenRT scene file to a location and name, e.g., C:\ProgramData\Bentley\AECOsim 
CONNECT Edition\Configuration\WorkSpaces\AECOsimExamples\worksets\SMART\Output\My SMART Building 01.lrt
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LumenRT is a quick and easy to use program for creating images and movies for project presentations. More terrain, landscaping, people, 
weather, seasons, birds, vehicles, sounds, etc. can be added to the live cube with the various tools. To learn more about utilizing all these 
tools, while in LumenRT press there is a series of introductory videos on YouTube: LumenRT for Beginners Learning Series. 

Experiment with creating more robust photos and videos after reviewing the tutorials.


